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Test Date

fSgR Tee IR @ifes suer fafAes

Test Time

9:00 AM - 10:30 AM

Subject

Correspondence Clerk and Store Assistant

Section : General Knowledge
Q.1 3ifad guraLrmedt Pret Fu1e 3 4 9Rd R 6 379 d a1 fBar oar?
Ans x 1.1605 - 1627

x 2.1627 - 1658

¢ 3.1658 - 1707

x4.1707 - 1760

Q.2 IERTd 4 &I PR 94, & fere ufirg &1
Ans x 1. T I aret i
x 2. OR-UB arel Hplp
X 3. PRI
o 4. TS 9R
0.3 FUfaf@d 7 q S9-A1 S 47 Ud AR HATAT GRT Y I IS '$-9H - 94 K9
HAieg A (eShram — One Stop Solution)' Ugd &1 diH Ui Hdl g2
Ans x 1. ITH0T 3EMRAT & oIV U faiia AreRar sried
x 2. 3=IR® &5 & SHAIRYT & U ASPIR &1 deb Uge & fev Uep fSfEied wiewid
X 3. IRBRI AB A8 dTall & fore AT FY F U 3iHars sifg gicd
v 4. FRTTSA bl & U B BeTUIBIRT ATSTHISN Pl Ubldpd B dlell U dbaldd i
Q.4 BIA 2024 #, Ffaf@d 7 3 A A3l & fore fasn—-ve Grafiél 3R Tarar
(Science for Women-A Technology & Innovation - SWATI)' Q1¢d @i f&ar?
Ans x 1. AAAY &id

X 2. gHA S
x 3. 1. MRS ga[E19H

o 4. 1. 3570 PR G
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0.5 5 oer A URAT Ju151 GRS 3R Jfden=  fFmfar &1 favrad & g 7 14 318«
2025 &1 MABIRS diR 1R 7. 1.3, 3ids® faw & ®q ¥ 9ifyd fear &2

Ans 1. gl A&
x 2.ccq
x 3.2%a
x 4. arfepre Sl

0.6 UGHR YUl B A qd Adi= ATATeid Bl IAD ArAref ey Afqemad1  FggA
freid gT&y & orqe &ar g1

Ans x 1. qgal
x 2. G
x 3. dreft
@ 4. A
Q.7 ¥ a1 Adgor vd A 39T RS &R1-2013 & HTAR, YS9 7 9ffHy &8ROI ST &4
SR fgferfad ¥ 3 oi-11 82
Ans 1. 3% &S
X 2. P HY
x 3. 31fe=mRor
x 4.3 P Bl

0.8 WA 2024 H, fég HeNPR AW &l 7di YY1 fd S H 3mAford foeam sran?
Ans x 1. SR
x 2. ATl
« 3. ARfern
x 4. ST
Q.9 ARd &I 2011 B SIPIVAT & FIAR, URd & FUfaf@d 7 A 169 A/dg A1Ad g d
IGRIERIGECR L
Ans x 1.37fsem
@ 2. P
x 3. g
x 4. dAeTg
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0.10 fgfafEad & & ®I9-91, IRd & Adi" ATATAT b1 TABTNAT BT UHTHE] 87
Ans x 1. 3Rf9P fepriRar

2. YD fABIRAT

x 3. 3741l fepriRar

x 4. RTHLTGT 31feapriRdr

Q.11 AT § Yuvde aelifiIP, 2025 (Superbet Classic, 2025) ¥ HIRdTF FSAIR AR.
gl 3 Si9-a1 gfafd f&dard sfar?

Ans x 1.9cs I8 I IMIARAY (World Rapid Chess Championship)
x 2. T2l Il I A1ed (Tata Steel Chess Masters)
& 3 ¥ 9 X dlgcd (Grand Chess Tour Title)

x 4. FIDE 7332 e (FIDE Candidates Tournament)

Q.12 SR AYUNYA BT §TTell § HJdIq B dTedl Ygell HJdiad BI- oA1?
Ans  x 1. Ud Gl H5HQR

x 2. ol 9etrH 31gHe

x 3. P13l T30 SIH

@ 4. A=A SR

Q.13 9Rd b1 FPIVAT 2011 & AR, B epf F SRI@ 9fg &R T 3P gaf B IS?
Ans x1.fég e

x 2.5915 e

v 3. M

x 4. 109 e

Q.14 I AN F AW Id® 4l a¥ d1g A 3rgurd ¥ Jarfagd &l sid &2
Ans x 1.UH-Ters

v 2. UB-fagrs

x 3.31-ders

x 4.31-fagrg

0.15 fHferfEa & I 5 Wre 7 Yfg A & fHar?
Ans x 1. g IS

@ 2. 3 IS

x 3. JILMed JHTS

x 4. gfgspd fgdeprRoult g
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0.16 Wdd! dry @erd ey 337 ¥ f/yd &2
Ans x 1.3RE3
o 2. JA5RATT

x 3. BAlcPH
x 4. 37fserm

Q.17 A¥d ¥ Yrelr AT BY RATYT Bd g3 2
Ans x1.1920

X 2.1930

x3.1828

v 4.1867

0.18 fAuferf&d # I feH7 ISR & A DI &I MeAPpsl I dgu-1 Ararsy 7 el fern?
Ans x 1.9gHT QT8

X 2. HEHg T

x 3. gHIY A8

v 4. TEHG 9T
0.19 &Y IFRTHT A1 7 ArdPbardl AT I gurfad ARBAT 3R AYAT B F@rId1 9ar

&34 & forv 28 318d 2025 P fafe =T 3ifep IR vsaidHl Aedad (Victims of
Terrorism Advocacy Network - VoTAN) = fear?

Ans  x 1. IIH Y Jra& gREg (United Nations Security Council)
X 2. TYTh Y AFAGAIEBR IRYG (United Nations Human Rights Council - UNHRC)
x 3. 34?[?1:23[?1 3MURTf&% =TI (International Criminal Court - 1CC)

v 4. TTTH Y ATdHaIg-FRNY S (United Nations Office of Counter-Terrorism -
UNOCT)
Q.20 WY AfFemT & 7S, 1948 b HTBT 66  ITAR, W bl HHG § FA1-1 AT 872
Ans o 1.3780fd 3R 3 FeA
x 2. U 3R & e
x 3. 9 3R U e
x 4. ¥l 3R TP e

Section : Logical Reasoning
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Q.21 9ia &AfB, L, M, N, 0 3R P & Gfth §f 3R &1 AR 1@ b 45 &1 P dftb & 10 8RR
AWM WVTT R ST I L fBAf ' BRI BT 81 M, L & GIU IR WIT R 96T 81 O, L
&I fApean sl 78 &1 4R”p P 10 BIR R 1 Ia1 &7

Ans x 1N
xX2. M
« 3.0

x4. L

0.22 39 YYY &1 9 SIS0 311 A QU 30 q Ig=dl & Jur- e &1 U0 Hd1 &
QT 9= U & A &1 AR B4 &

NS - PU - RW
DI - FK - HM

Ans x1.GL-IM -KP
¢ 2.GL - IN-KP
x 3.HM - IN - LP

x4.HM - IM - KP

Q.23 Uk PHYSICAL # 318R1 & 0 a1 I (31131 Bl AR AATq A-Z F &1 7 3R 68 61 30

3ofd Z-A & ®H | B17 31 wR) g, 50 s § 39 dfig 3d73 & 318R & foraq 3030
qufaren &0 & 39¢ di9 &2

Ans x 1.0 off 781
x 2.d9
x 3. U

v 4.3

0.24 & 7S Y@cll § 9y &g (?) & R IR T 31T 91fge?

217 220 225 232 2417
Ans x1.260
X 2.264
x 3.267

v 4. 252
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0.25 Fferf@d Jw-goi 7, ygell WA IR 8 0T ATBATT SIb Ul JWAT U1 61 ATl
&1 DIF-H J@0 X 3R Y &1 yfanfyd 36, dife :: & 918 3R Y & =130 gIRT

ITART BT 17 drelt de : & 18 AR $T 41 AWA37 gIRT 3TAV U 511 ared def &b
|91 8l?

(Are: J@A3M B 3P gcP 3idl A dis a1, Jfpard guf J@asi ur $i st =nfgel
3GTERY & felv 13 efifarv - 13 4R JAfpAT? 3 13 T SNZA1/9TH1/5700 SR fHAT 31 AHdl
&1 13 &1 131 3 & drs=r a1 63 1 31R 3 R MO AfeATT B3I 61 3rgafa 4 81)

X:57:24:Y
Ans x1.X=12,Y =169

& 2.X=11,Y=122

x3.X=12,Y=166

x4.X=13,Y=167

0.26 IfE '+ 3R 'x' B IR 9 AT ATV a1 '—' 3R '+ B R 9 &A1 FATC, df
fgferRad afieor § yy-fag (2) & &A1 93 &7 302

4x14+7 42 -6=2
Ans x1.90

x 2.85

x 3.100

v 4. 95

Q.27 3iA3h quidrer ®H 4R 3nenid, Fafaf@d =R 3eR-Jqg IHi d A i v [Afgd adfie d
UHIAT ¢ 3R 3 YBR U YU d-1d &1 DI-AT HSR-IE oA 39 YU A J&fard ¢ &2
(A1<: 3RTd HER-TYE P, ASTHI/IWRT b1 YA A1 3961 AT v 3mrenid =& 81)

Ans 1. MO-PS

x 2. Gl-JL
x 3.LN-0Q

x 4. AC-DF
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0.28 Bg dldd A, B, C, D, E 3R F UP & HUI UP IA@ U g, aifpd SIu3) 81 fop d sl o0 o 3@
M0 &1 E & A9 q gAY AT 93 3461 311 &1 F 3R B & o9 bdel U diaRT @M 31T &1 E
3R D & §19 Fad diH SR IF T &1 A BT E & SIF 13 391 A1 81 C B B & 5P JWR
IE[ T &1 PY-WT §icd, HUR F AR AT U3 34T 37T 872

Ans x1.C
& 2. F
x3.D

x4.B

Q.29 U B3T3 Bl AISHR Bblel ATdl & T fob i gfr 3= 81 89 ST &1 Al 4R I8
&1 fears om?

Ans .10 OO0 ¢
O O
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0.30 3 9= &I 934 HIfoe Brad J@ae 3t yoR ddfad € iR Yo 6 fFafafad
AT 6 T=AT0 g
(Are: srfordig AlpaTe, UBAT3M &I 39 gce il § dis foqr, guf Ywarsi uv &1 -t
q1fev1 3qT8R 0T & forv 13 &l ifSv - 13 R IAford Afepard S 6 13 &1
SIgAT/9eT-1/3[0N BT, S f6AT ST ABAT 2113 BN 13R 3 TASAMIR R 13IR3 W)
ot WfpATT S Y rafa L 1)

(5,17,27)
(7,15,29)

Ans 1.(273,57)
x 2.(19,13,39)
x 3. (11,12,50)

x 4. (23,11,53)

0.31 Fufaf&d g@en &1 daH difae 3R QU e gy &1 IR fAfsrel Pradt dde a1 I o 61
sty =nfgel

(STO) TXRENHOFEJFNXIEA O U (GIV)

&1 31 @l ¥ 910 B8R A 8 AR & Q0 dRIRT AER BI-1T 872
Ans x 1N
x2.U
v 3.E
x 4. F
Q.32 I 8735412 & YdA® 3id &I 410 I QI ARIE 4 ¥ Fal¥d BT 311 &1 gel A=A Hl
qor1 | faq 3ie/3iel 1 Afa afvafdd w@fi?
Ans x 1.0 off 98
x 2.4
v3.0F
x4.d
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0.33 U fAfYd a1 A DF 10 &1 A& 1K 20 A g1 3 UPIR, MO 17 &I &g RT 27 A g1 AT
dd T AV BId §U, LN 46 BT &g QU 70 fyedl 7 F A 872

Ans x1.5U56
x 2. RT 51
v 3.0S 56

x 4.0S 51

0.34 If& AT 1853674 B YA P fAYH 3id § 1 3NST MU dAT AP I 3id § A 2 "1 310, d)
o3 YBIR &l 13 J@AT § 910 I gAR dA1 &0 F A il BT JI5T &1 8IoT?

Ans x1.10
x2.12
v 3. 14
x 4.1

0.35 Fgfaf@d J@ g@o oI AdgH o 3R A3 U 10 g &1 3R &1 (Wl YAV Fddd v
3i® qrefl Y=Y &1)
(§T0)5795321348642798146823509 4 (3I0)

03 fodq faun 3ia g, S0 A UdP & P g Udb fa9H 3id ¢ dl b dI¢ Us A1 3k
oft 22 (P Faa 910 I <0 61 31+ &)

Ans x 1.Udb
v 2. 3R
x 3.3l
x 4.9
0.36 3iAft quiHTell 1 & AR YR DANCE U fAfdd db & FAR JGTIK I Adfad &
CHOSEN 331 @ & 31TAR INUYKT 3 Hefld &1 FHI ddb &1 AR BId gU ACTION
fgu v el & F frad wefaa &2
Ans 1. GgIzout
X 2. GIZOUT
X 3. GIZOVT

X 4. GIAOUT
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Q.37 3iASH quinrer 1 & YR R, FAYfafdd IR 3eR-Agg 4 A di9 v Ay aiis @
UHIAT § 3R 3 bR d U YU -1d &1 BI-AT1 318R-Tg 39 I4 I Adfad 78 &2
(A1<: 3R HER-TYE, ASTHI/WRT b YA A1 | 391 ATA v 3nend =21 81)

Ans x 1.LPK
x 2. NI
« 3. NRO

x 4. HLG

0.38 FHfeIf&d 31&gR g&@el &1 daHf o 3R 3Td d1g QU 7T 9y &1 IR &1 B Haa a0
Qe &Y S &1
(M) EMOZIDWAUSLFPBYJTNRGVHC X (30)
gEa ¥ 910 & 98l R 3R 310 3 9gd WX F A9 fpd 38R &2

Ans x 1.dR
x2.ad
o 3. 91d

x 4.9

0.39 & 718 g@cll # YY-g (?) & AT U T 311 d1fgv?

16 20 253138 ?
Ans x1.44

x 2.45

x 3.47

& 4. 46
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Q.40 U fATYd He wrvr 4,
‘A+B BT AT 1H A, BB A &
‘A-B BT 3f ¢ fF A B PS¢
‘AxB &I 3f ¢ fF A, BH gl &
‘A # B &I 32l g fp A, B &1 fUdr &

39Yth S MYR WR, G H-E+Rx O #1I'g, dl H BT J T ey g?
Ans x 1. fodr

v 2. 98

x3. 97

x 4.9fd

Section : General English and Comprehension

Q.41 Select the most appropriate option to fill in the blank.

The weather in the mountains can be _ unpredictable.
Ans x 1. fairly
& 2. rather
x 3.too
x 4. much
Q.42 Select the most appropriate option that can substitute the underlined word in

the given sentence.

The decision was met with widespread approval from the community.
Ans x 1. temporary
« 2. general
x 3. limited

x 4. silent
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Q.43 Select the option that can be used as a one-word substitute for the given group

of words.

A state or feeling of great unhappiness or suffering
Ans x 1. Joy
« 2. Misery
x 3. Bliss

x 4. Contentment

Q.44 Select the most appropriate meaning of the given idiom.

To make a long story short
Ans x 1.Tointerrupt someone frequently
x 2. To tell a very detailed account
x 3. To change the topic

« 4. To summarise briefly

Q.45 Select the most appropriate option to fill in the blank.

Shecried  for help when she saw the danger.

Ans 1. frantically
x 2. urgently
x 3. boldly

x 4. gradually
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Comprehension:

Read the given passage and answer the questions that follow.

Over the past decade, e-learning has transformed the way students and
professionals acquire knowledge. With internet access becoming widespread,
learning is no longer confined to physical classrooms. Digital platforms now offer
interactive courses, recorded lectures and personalised feedback, making
education more accessible and flexible. Students in remote areas can attend
classes from top institutions, while working professionals can upskill without
leaving their jobs. E-learning also supports a variety of learning styles—visual,
auditory and kinesthetic—allowing learners to progress at their own pace.
However, the shift to online education also presents challenges, such as screen
fatigue, limited peer interaction and the need for self-discipline. Despite these
drawbacks, the benefits of e-learning are significant. It promotes lifelong learning
and democratises education by removing geographical and financial barriers. As
technology continues to evolve, e-learning is poised to play an even greater role
in the future of education.

SubQuestion No : 46
Q.46 What is the most appropriate title for the passage?
Ans 1. Benefits and Challenges of E-Learning
% 2. The Rise of E-Learning

x 3. The End of Traditional Schools

% 4.0nline Gaming and Education
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Comprehension:

Read the given passage and answer the questions that follow.

Over the past decade, e-learning has transformed the way students and
professionals acquire knowledge. With internet access becoming widespread,
learning is no longer confined to physical classrooms. Digital platforms now offer
interactive courses, recorded lectures and personalised feedback, making
education more accessible and flexible. Students in remote areas can attend
classes from top institutions, while working professionals can upskill without
leaving their jobs. E-learning also supports a variety of learning styles—visual,
auditory and kinesthetic—allowing learners to progress at their own pace.
However, the shift to online education also presents challenges, such as screen
fatigue, limited peer interaction and the need for self-discipline. Despite these
drawbacks, the benefits of e-learning are significant. It promotes lifelong learning
and democratises education by removing geographical and financial barriers. As
technology continues to evolve, e-learning is poised to play an even greater role
in the future of education.

SubQuestion No : 47
Q.47 Which of the following best summarises the passage?
Ans x 1. Technology has no place in classrooms.
% 2. E-learning is harmful due to screen time and loneliness.
« 3. E-learning helps make education accessible despite some challenges.

% 4. Online education is a temporary trend.
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Comprehension:

Read the given passage and answer the questions that follow.

Over the past decade, e-learning has transformed the way students and
professionals acquire knowledge. With internet access becoming widespread,
learning is no longer confined to physical classrooms. Digital platforms now offer
interactive courses, recorded lectures and personalised feedback, making
education more accessible and flexible. Students in remote areas can attend
classes from top institutions, while working professionals can upskill without
leaving their jobs. E-learning also supports a variety of learning styles—visual,
auditory and kinesthetic—allowing learners to progress at their own pace.
However, the shift to online education also presents challenges, such as screen
fatigue, limited peer interaction and the need for self-discipline. Despite these
drawbacks, the benefits of e-learning are significant. It promotes lifelong learning
and democratises education by removing geographical and financial barriers. As
technology continues to evolve, e-learning is poised to play an even greater role
in the future of education.

SubQuestion No : 48
Q.48 What is the tone of the passage?
Ans x 1. Critical and harsh
x 2. Disappointed and negative
% 3. Humorous and playful

« 4. Balanced and informative
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Comprehension:

Read the given passage and answer the questions that follow.

Over the past decade, e-learning has transformed the way students and
professionals acquire knowledge. With internet access becoming widespread,
learning is no longer confined to physical classrooms. Digital platforms now offer
interactive courses, recorded lectures and personalised feedback, making
education more accessible and flexible. Students in remote areas can attend
classes from top institutions, while working professionals can upskill without
leaving their jobs. E-learning also supports a variety of learning styles—visual,
auditory and kinesthetic—allowing learners to progress at their own pace.
However, the shift to online education also presents challenges, such as screen
fatigue, limited peer interaction and the need for self-discipline. Despite these
drawbacks, the benefits of e-learning are significant. It promotes lifelong learning
and democratises education by removing geographical and financial barriers. As
technology continues to evolve, e-learning is poised to play an even greater role
in the future of education.

SubQuestion No : 49
Q.49 How is the passage structured?
Ans 1. General-to-specific with examples and consequences
x 2. Dialogue between teacher and student

x 3. Personal story of an online learner

x 4. Timeline of internet history
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Comprehension:

Read the given passage and answer the questions that follow.
Over the past decade, e-learning has transformed the way students and
professionals acquire knowledge. With internet access becoming widespread,
learning is no longer confined to physical classrooms. Digital platforms now offer
interactive courses, recorded lectures and personalised feedback, making
education more accessible and flexible. Students in remote areas can attend
classes from top institutions, while working professionals can upskill without
leaving their jobs. E-learning also supports a variety of learning styles—visual,
auditory and kinesthetic—allowing learners to progress at their own pace.
However, the shift to online education also presents challenges, such as screen
fatigue, limited peer interaction and the need for self-discipline. Despite these
drawbacks, the benefits of e-learning are significant. It promotes lifelong learning
and democratises education by removing geographical and financial barriers. As
technology continues to evolve, e-learning is poised to play an even greater role
in the future of education.
SubQuestion No : 50

Q.50 What is the central theme of the passage?

Ans x 1. Internet has become more affordable.

« 2. E-learning is transforming access to education.

x 3. Online courses are easier than in-person classes.

x 4. E-learning is replacing traditional education.

Section : General Hindi and Comprehension

Q.51 ‘39" HI faalid A BI -
Ans  x 1.g3UAM

X 2. 3TFhof

v 3. 344D

x 4. 139D
Q.52 ‘&ur &1 gATIardt I &?
Ans X 1.3

x2.79

X 3. &RT

@ 4. fauraRt
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Q.53 ‘4TS S HeraxT &1 gl 3 g -

Ans 1. N 9T Fcdtd B
x 2. 916 B Bl Jurfgd BT
x 3. BfST g9 BT
x 4. JgY T T Idid BT

Q.54 'JMPTA SJH ST BT 3¢ §-
Ans x 1.7 &

X 2. X

x 3. g g

v 4. 75T I TR &l
0.55 3RId ®R® A=l BT Y411 HId gU arey guf &3-
MM ---- A @8 |
Ans x1.H
2.7
x 3. Pl

X 4. R

Comprehension:
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f&@ 310 sreri: o1 & 3MMemR WR fAifeed vl & 3R Ifsre--

a7 & QT TG B dell BT AT &1 WRdA H 390 Sferdt €1 Y Sferdt e & e ¥ SRR B
Bl §18 AT I 7S WINT BT g HER AGeg aicll &1 &l off vep O & o 21 Forad 3
&g el & orsg TR #1311 H 90T &1 &1 51 IR W A wiwig ffderem &, 330 g Igf W™
iepiaes fafaerar off faemr &1 urars fafaerar o1 319 € - U Wi & § 314 WIIst & -
3R | uRd § Ig fafderdr o, 3gamy, fofd, 3=Ror 3R el & IR o off St STt 81 uRd #
19,500 I 371 9T9TY 3R Siferit ars St &1 597 I 7907 121 9T9I3T &Y 98 ¥R 9 Sl Sl &l
aRd ¥ fafderar sadbl gad 381 3R a9y uganq g1 Jg fAfderdr daa urer db a2l &, afcs
e, ST, AP, W1, YgraT, TR, V&R, Pie 3R Sia-1eiell de $efl g &1 Igf 3 Sfd,
e 3R & & ol e B &1 9Rd § Ioft el & AR, YaT-Ugfa, 3R enfii 32/t fAdd g- o
& HfeR, ARSTE, I, THgIR A1 WIRd BT 9Phd off fafdedr F Ry 8- 3R | fgnrery, g § 99g,
afge § PR, 3R gd § g9 ShTeT| & & &1 391 YgATal, WA 3R dibbart gl afe i of
EHIRY JTPY U G0N 3R H3Tgd &1 Ig bdel U ARI & &l ¢ dfc URAT sha e &1 get &1
Jg Bdcl Bl AT 781, dfep v Ul fRId ¢ SRy Nl &3 Nl 31191 Seran a1 g1 fafderar
T Uar &1 uId gi RIErdr ¢ 6 7d¥G @4 & d1ds]g &H AP 3§ Jbd ¢l WRd AU Hel ¢
HIfep Fgl & e & off 39199 & |

SubQuestion No : 56
Q.56 WIRd &I 9NTS AT T 872
Ans 1. FgTdl
x 2.994
x 3. fawfaa

X 4. WAy

Comprehension:
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f&@ 310 sreri: o1 & 3MMemR WR fAifeed vl & 3R Ifsre--

AT & QT R BT dell BT AT &1 WRdA H 390 Sferdt €1 Y Siferdt e & e ¥ SRR S
Bl §18 AT I 7S WINT BT g HER AGeg arcll 1 &l off vep O & oo 21 Forad 3
&g el & orsg TR #1311 H 90T &1 &1 51 IR W A wiwig ffderem &, 330 g Igf W™
Jiepiaes fafaerar off faemr= &1 urars fafaerar &1 319 € - U Wbnfaie & § 314 WIIst & We-
3R | uRd § Ig fafderdr o, 3gamy, fofd, 3=Ror 3R el & IR o off St STt 81 uRd #
19,500 I 371 9T9TY 3R Siferit ars St &1 597 I 79T 121 9T9I3f &1 98 ¥R 9% arel Sl &l
aRd ¥ fafderar sadbl gad 381 3R a9y uganq g1 Jg fAfderdr daa urer db a2l &, afcs
e, STTfdl, AP, W1, YgraT, RN, V&R, el 3R Sia-<iell de $efl g &1 Igf 3 Sfd,
e 3R & & ol ey B &1 9Rd § Ioft el & AR, YET-ugfa, 3R enfiies 32t fAdd g- o
& HfeR, ARSTE, I, THgIR A1 WIRd BT 9Phd off fafdedr F Ry 8- 3R | fgnrery, g § 99g,
afge H PR, 3R gd § g9 ShTeT| & & &1 391 YgATal, WA 3R dibbart gl afe i of
EHIRY JTEY U G0N 3R H3Tgd &1 Ig bdel U ARI & &l ¢ dfcd R sha gefH &1 get &1
Jg Bdcl Bl AT 781, dfep v Ul TR ¢ SRy Nl &3 Nl 3119 Jeran a1 g1 fafderar
T Uar &1 uId gi RIErdr ¢ 6 7d¥G @4 & d1ds]g &H AP 3§ Jbd ¢l WRd AU Hel ¢
R Fgl & e & off 39199 & |

SubQuestion No : 57
Q.57 NI & 1T ®Y B AT H&l JTaT 82
Ans x 1. HI9H HIET
@ 2. 9iell

x 3. HINT

x 4. &A1 e
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Comprehension:

f&@ 310 STerf: ior & 3MTemR WR fAifed vl & 3R Ifsre--

AT & Q1 TG B dell BT ST 81 WRd B 310 Sferdt €1 Y Siferdt arer & e ¥ SRR B
Bl §18 AT I AP WINT BT UG HSR AGeg aidl ¢l &l off vep O & oo 1 Forad 3
&g A & orsg TR #1=1 H 9T & &1 51 IR W H wWiwig fafderem &, 330 g Igf W™
iepiaes fafaerar off faemr= &1 wrars fafaerar &1 319 € - U bnfaie & § 314 WIIst & e-
A | uRd § Ig fafderdr o, 3gam, fofd, 3T 3R el & IR o off St St g1 uRd #
19,500 I 371 9T9TY 3R Siferit ars St &1 597 I 1907 121 9T9I3f &1 98 ¥R 9 Sl Sl &l
aRd H fafderar sadbl gad 381 3R A9y ugarq g1 Jg fAfderdr daa urer e NfAd 2l &, afc
e, STTfdl, AP, W7, Ygrar, RN, &R, el 3R Sa-eiell de $efl g &1 gl e Sfd,
e 3R & & ol e B &1 9Rd § Ioft el & e, YaT-Ugfa, 3R enfiis v2ref fAdd g- o
o5 HfeR, AfSIE, 99, TTHgR 371 W &1 opiet off fafderdr & oR9R 8- 3R H ferery, gfayr ¥ 9qg,
ufge ¥ PR, 3R gd ¥ g9 ShTeT| & & &1 391 YgATal, WA 3R dibbart gl afe i of
EHIRY LT Tl HGUUT 3R HAslgd &1 Ig bael Ueb ART & el ¢ dfcs YR NI g2 &1 4o 2|
Jg Bacl Bl AT 781, dfep v Ul fRId ¢ SRy Nl &3 Nl 3119 Seran a1 g1 fafderar
¥ Uaar &1 o1 g A & 5 Addic 813 & 195G g9 MddR I8 IHd &1 9IRd sy HerT @
R Fgl & ozAem & off 39199 8 |

SubQuestion No : 58
Q.58 'AGUUT K BT 3 FAT & &2
Ans x 1. HRdd
X 2. Hg
x 3. Bl

o 4. omed
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Comprehension:

f&@ 31U 7eri: o1 & HTeR 9R Fmifed ugl & 3 §fSv--

09T F T Y P delt el a1 81 URd & 370 aiferit &1 3 SRt w1 F [ ¥ SRR F1
Bl &1 3 Aferdl I HIb AT P g HER TG arar &l &t off v O & ooy &1 et 3y
gl Sifcrdl & orsg IR A A 91T & 1 5T bR R | qrerg fafderdr &, 33 gk I8l I
e fafaerar off faemr g1 s fafderdr &1 31 § - v dbiifeie 8 § 3 w3l &1 Je-
R | WRd § Ig fafderdr o, gy, foifd, 3=RoT 3R el & TR o) ot St i1t g1 uRd §
19,500 I &b WIuTY 3R AT I1E et &1 A5 I 1 121 ATN37 Pl d3 IR IR Sl STl gl
aRd H fafdear gl g9 381 3R a9y ug=nq g1 Jg fafderdr daa urer db AfAd =2l &, fep
e, STy, TRGpTel, WIUT, T, WY, RNER, P 3R Sia-eiell de Sell g8 gl Tgl 31 i,
e 3R 8 & AT A B &1 uRd § Joft el & AER, GoN-Ugfd, 3R enfie e fad &- s
3 HfeR, ARSTE, T, THgIR M| WRd BT ophd off fafdedr I RyR 8- 3R & fewrery, gfaror & 99g,
afgm § 30, 3R gd & g9 SP1et| 8% & BT 3791 UgATal, WA 3R aiedart gl afed O off
BT AT Ul 318[00T 3R FSIgd &1 TE Had U AR & Tel & afedp URA sfia- gefH &1 §d 8|
JE bad ARplae 3ATar 781, afces v 01 forTaa & o fiel &= et AT S@ra 1 g1 fafderar
T UHdT BT 919 g RIEraT ¢ 5 a0 @9 & SIds|g 8H Mad: 38 Wdbd &l 9Rd AU HeH &
i T2l & Mddr ¥ off g9 ¢ |

SubQuestion No : 59
0.59 '3®dl ¥ Uadl-fa< ) fAATAr HRd & fore 0UT o1} H&l STdT 872
Ans 1. ST, e, TRepfer 3R A1 B fAfderdn gq
x 2. AT AETS 8
x 3. enfifes qers &g
x 4. PN fawdR &q
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Comprehension:

f&U 7@ ez ier & AR R Fgifed g9l & IR §fSe--

09T F AT Y BT el el a1 81 R ¥ 3175 aiferdt &1 Y et w1 & [ ¥ SRR $11
Bl ¢l 2 Sl § 7P A1 BT g HER A el &l &l off vep Ul & oo &1 5w 39
&g A & orsg TR #1=1 H 9T & &1 51 IR W H wWiwig fafderem &, 330 g Igf W™
Jiepiaes fafaerar off faem= &1 urars fafaerar &1 319 € - v Wi & § 314 WIIst & -
IRAT | ARd & g fafderdr e, 39umT, fafd, 3=Ror 3R el & TR 9R ot S el &1 R &
19,500 I 371 WT9TY 3R Siferit ars St €1 597 I 7907 121 9T9I3f &1 98 ¥R U Sl Sl &l
URd H fafderdr 2Tl Ta 38 3R A9 gg=r g1 Ig fAfderd et 9w d Wfd 78 ¢, dfcs
e, STTfdl, AP, WITUT, YgraT, RN, AER, WPiel 3R Sia-eiell de Befl g &1 gl 3 Sfd,
e 3R & & ol e BRd &1 aRd § Ioft el & R, GaT-ugha, 3R enfiies o feld §- s
o5 HfeR, AfSIE, 99, TTHgR 371 W &1 opiet off fafderdr & oR9R 8- 3R H ferery, gfayr ¥ 9qg,
afgw HIFRA, 3R qd & g9 5711 &R &5 BT YA UgATdl, Wi 3R cipbant g1 afe 52 off
BHIRY T U AT 318[00T 3R HIIgd 21 IE Hacl U ART & & ¢ e IR e gefF &1 g 1
IE e WRBiad AV 78, dfep U O fRrwrd & o Nl ar it A1) agran 1 g1 fafderan
¥ Uaar &1 19 g A & 5 Addic 813 & 195G g9 MddR I8 IHd &1 9IRd 33y HerT @
HI1ep Fgl & e & off 39199 & |

SubQuestion No : 60
0.60 SIferl} &I FT Hgd &7
Ans x 1.35HIfd® Agcd
x 2. &1 g8
v 3. A Y8R 99fg
x 4. B UebdT & felv

Section : Basic Knowledge of Computer
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0.61 RMATH! ¢RI (Steganography tools) fEIBT U I &2

Ans x 1.5 RARINE (Computer Security)
x 2. ATRTET Rven RN (Operating System Security)
x 3.792d% RAIRS (Network Security)
4. SBIHIA RIFRE (Information Security)

0.62 THUI-URI  WsAle &l 'save as' 31 & ferv FAgferfad & I fog HI4IS didde &I
39T BT SATAT 82

Ans x 1.F1
2. F12
x 3.Ctrl+S

X4 Alt+T

0.63 LAN &I WAN 3 30133 & felu Ira1=Id: fpd f3arsy &1 39ANT fBAT SIrdr &2
Ans x 1.4sH

¢ 2. T3R

x3.89

x 4. @@=

0.64 MS-Excel 2016 &, ®Tcd &I 9ISTS AT A (row) B HAIS §¢add & falw, TR AT
SR

Ans x 1. Design -> Cells -> Format
« 2. Home -> Cells -> Format
x 3. File -> Cells -> Format
x 4. Insert -> Cells -> Format
0.65 fdsIaT 10 3ARfET Red & $id e § 3uare FAgfarfad & d ®19-91 fadeq, A3y

faarsy &1 IR Wudiat A fb A3 yiged 3R ge7 SIf-HRAT & - ¥ JgrIadr
Bl 87

Ans x 1. Appearance and Personalization BSIRN & A Td Mouse Properties fd®eq
x 2. Hardware and Sound %2331 & 3idfd Add a device fd&ed

x 3. Hardware and Sound %31 & 3iddTd Adjust commonly used keyboard, mouse and
mobility settings fadeq

« 4. View devices and printers / Ease of Access d¢%1 & 37dd Mouse settings fad®ed
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0.66 fryferfad & & S19-31, arss URAT Acad (WAN) &I Udh JHRR &2

Ans x 1. Cloud-managed WAN
x 2. Voice over LTE (VoLTE) WAN
« 3. Internet WAN

x 4. Adhoc WAN

Q.67 3U®! UHUH URId § U VT seTde fadr s & S 'Product’, 'Units Sold', 'Unit
Price' 3R 'Discount Rate' & Picid WG &1 ID! B @ I & dIg YAP Usdw &
feTe et Y34 b1 STUMAT BT &1 el ¥d=x 1 VAT (Units Sold) x (Unit Price) x (1 -
Discount Rate) & ®9 ¥ &1 3Tdl &1 TS 'Units Sold' ¥« B2 ¥ &, 'Unit Price' Aa C2 T &
31R 'Discount Rate' ¥el D2 H &, dl Fuferf@d # d &1-91 Y7, el £2 7 {5 Msqe &
feTe et Yd=g b1 Jal 0T B2

Ans x 1.=B2*C2*(1+D2)
x 2.=B2*C2-D2
« 3. =B2*C2*(1-D2)
x 4.=(B2+C2)*(1-D2)
0.68 fHferf@&d & d ®14-A1 9Y (path) fdsisl A SRS IST 1 UGIIHAd JTA (hierarchical
structure) &I Jgl fRYUT BIdT 82
Ans x 1. C:\Documents\Users\MyFile.txt
« 2. C:\Users\Documents\MyFile.txt
x 3. Users\C:\Documents\MyFile.txt

x 4. Documents\C:\Users\MyFile.txt

0.69 AT BT IUADT Ed: fpwafere fBar sirar &2
Ans x 1. 39 IR IS BT
x 2. AR A AT

« 3. ARBIA T ATaATies vy fergT 3R A8 &A1

x 4. e Aifor
0.70 fFHff&d # § S19-A1 by gAY fEarsy &2
Ans x 1. qdie

2. AIShI B

x 3. %bI

x 4. 28I



https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Adda247

Q.71 MS a3 ¥ 31 SiepgHc Hid1 & fov FAgfafdd d A 9 HIds didee 1 39T fHAT
SITdT 82

Ans x1.Ctrl+W
¢ 2. Ctrl +N
x 3.Ctrl + 0

x 4. Ctrl +Z

Q.72 1024 9IscH, & AR gIdl 8l

Ans x1 | MB

X2.1TB

v 3. KB

x4. 1GB
Q.73 UHUY 98 ¥ RIATEG UATsAHC Ga & folv f5d 29 &1 39T 5T SI1dT 82
Ans x 1. Reference ¢d

X 2. Review eq

« 3. Home cq

x 4. Insert cq

Q.74 PTel %11 #, fe 99 951 &I i S & felv, g 49 931 & HUA-a10 Si J 3uare
"BICAISS U Dlel PTel BIN' YA & 3id’fd e« fiie g4 R faeld A1 M|
AR A AfIRB AT PRI S v, g A gu e sraciTdicdd .~ AR faas
BT BT

Ans x 1. 399 (Open)
x 2.9d U] (Save As)
x 3. e (Print)
v 4. AR TS (More Settings)
Q.75 pTd gRT fAgfarfEa § F d1-M ¢ argadl fadua: Uaiss & fev fasfad 61 s g, 3l
midrgd f3arsdl & ferv 3@ ferd (optimised) &?
Ans x 1.Ugig8 C @sskT (Android C Library)
x 2. GNU C ergsiRl (GNU C Library)

« 3. 114 (Bionic)
x 4. Fas® (glibc)
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0.76 "IN 93 H, fel sTagic I Ad HI1 61 AicHde Pl [T &2

Ans x 1. Ctrl+C

x 2. Ctrl+X

v 3. Ctrl+S

x 4. Ctrl+V

Q.77 UHUY YTaRyise ¥ s Yl fopue &3 & Wdl dadier fAyfarfad § & o19-31 82
Ans x 1.Insert ¢§ > Slide > New Blank Presentation

« 2. File 28 > New > Blank Presentation > Create

x 3. Design ¢d > New Slide > Blank Layout

x 4. Home 29 > New > Blank Presentation > OK

Q.78 $I$ YR YA UHTY Uiavyige U ¥ 48 W38 A 08 B Addl 8?
Ans x1.'View > New Slide' R fdid &3

x 2. 'Animations > New Slide' TR faeid @

« 3. 'Insert > New Slide' TR facids B3

x 4. 'Design > Add Slide' TR faeied B3

0.79 fryfafad § J &9-A1 2 AR APIRST B $-yAed AT (e-tourist visa) UG BIdT
&?
Ans 1. Gf&I0T 3T0hIehT
x 2. R
x 3.0
x 4.d19

0.80 ®I-Ht faffy, PC 4z 3MRN-3 ae¥faferdisl (zero-day vulnerabilities) ¥ faog daiaH
R e yar sdl &2

Ans 1. dSddT A8 (sandbox mode) & ATHEAIR 39 HAT
x 2. JifeIAfe® 393e fRdad Bl
X 3. Pdcl BIIRdIA e IR FAuR 351
x 4. Q1 VAR BT 39T AT

Section : Quantitative Aptitude
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o081 L L 1 L Rd Hifawl

72X 74X78 X716
) 5
Ans x 1'7E
) 11
15
716
A
T716

Q.82 ( 1,57 P! A B4 (vulgar fraction) & uRafdd Hifsrel
Ans x 1. 329

v 3.

x4

0.83 15 x 3 x 990 + V3025 = y + 957 I UQE B dlal y &I A lTd HIf|
Ans x1.-137

x 2.-153

x 3.-155

v 4. -147

0.84 160 m 3{R 90 m <idI$ dTrell GI YPMSAT BUE 40 km/h 3R 50 km/h &1 a1 I U &
f&em & 91 & €1 U g B UR B F 3% fHd-1 AT Pem?

Ans x1.753%%
« 2. 90 JPbs
x 3.95 Jbs
x 4. 80 &3
Q.85 U $g ¥ 15 faenfHal & 3idl &1 30d 45 81 AT UAS fqeneli & 3id QA S QU 30,
dl 731 3ad 9rd SIf3e|
Ans . 1.90
x2.15
x 3.30

x 4. 45
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0.86 tngqumé$$r mﬂ24aéﬁmwm%3ﬂ?m3qg3¢ﬁ%$mmmoEl%fr

‘H‘\’WFIT%IPﬁ?QEﬁ:ﬁmgﬁfﬁﬁﬂ%H$an?@T[ﬂT ﬁﬁ?éﬁfﬁaa$ﬂ?:mnml
Y Bdcl UTSY R &I Wiell AT 3R 39 &P &I UT-t 7 §¢ | @relt &3 feAqri 4rsy p, Q 3R
R iR @refl & &) fpda 0y ¥ R I&d 87

Ans x1.91%¢
x 2.99 §¢
x 3.101 8¢

w4842

Q.87 13 x 2 x 500 = V7500 = y + 684 P WAE P AT y FT A7 g1 FIfSre
Ans x1.-422

v 2. —424
x 3.-428
x 4. -434

Q.88 U ATIRT A 39T HIel 20% bI e R &1, dAfbq 39 YAP dvq IR «°Id eI 4 30%
3P g 3ifed fHaATI Yd® 93d U= 3APT 1y Ufd2rd sird SISl

Ans x1.5%
v 2. 4%
x3.8%
x 4.10%
Q.89 M 3R N &I ad a1 3 HHLE, 4 : 5 F 31F41d ¥ &1 i af ygal, 37PT 31 BT 3Urd
BHLE, 7 : 9 AT AT T M &1 311 (auT 7) fHa-i &2
Ans x1.28
x2.20
v3.24

x 4.30
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Q.90 P ¥ePIIsl 80 km/h &1 ATel A Ferdl 8112 fAE FIPNI gIRT dF B 71 g (km )
GIGKIIELY!

Ans »1.16

x2.14
x3.12

x4.10

Q.91 U8e 10 a9l #, Uep B3 $I S-RITAT F 20% $I I g8 &1 10 ¥ Ugel B B STHSA
25,000 oft1 319 &3 6 4@ fodt &2

Ans 130,000
x 2.31,000
X 3.29,000
X 4.34,000
Q.92 30 kg g, fSrAPT BIHd T45 Gfd kg &, Pl 15 kg 3T YPR & 31g & AT Acrd? Ua g
9131 SATdT @ SR1ehY $iad 50 Ufd kg &1 9831 31g &1 Ufd kg qed (T #) S1d HIfse)
Ans x1.50
x 2.55
¢ 3. 60

x 4. 45

0.93 U® Afb Y- 3 BT 60% JdTdT &l G ITPBT AF 560 &, di IAB! 3 (X /) fHa-i
&?
Ans x1.1,440
x 2.840
v 3. 1,400

x 4.700
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0.94 U% ATYY G 9¥qU X 3R Y &P &I ¥500 § WGl &1 dg 3799 I Ud® IR J°14 I
3ifPd BT &1 98 TG X B 25% IR 12% 6 Q| Bl Fe SHT d9dl & 3R 3 off ¥388
&1 o1 31f3fd B3dr 81 AfE 98 avq) Y BT 34% 6 Udbel e UR 99dT &, dl Y W o1y gfderd
GIGEIIS Y

Ans }(’1. 76.6%
X 2. 76%
¢ 3 77.6%

F. 4. 77%

0.95 50 YXd®! $I [ Yed, 24 GAPI & I oI & RIS ¢l &1 A1 oy yfaad srd
$ifarel

Ans x1.100, &fy
26

x 2. 100 oo
26

o 3. 5204 gTﬁ

X 4. 5720, Y

0.96 @Ifd®T b1 adar4 3G BT 3 AT, AATPS HI IdHI 31 P 2 33 F 17 a9 AP &, dAT AATP
b1 IdHI-1 31 BT 8 I[1, eifcipl B adHI 31g b 9 I3 A 17 99 B &1 eifarepr 3R AAP
61 adur A &1 AT (9Nt J) fHa-r &2

Ans x1.30
x2.32
« 3. 34

x4.35

0.97 A, B 3R C HePI-31eT Tl &1 B Bk 24 &4, 30 &7 3R 40 &7 7 GR1 &% P4 ¢l
g 3 Aoft U A1 BT BT Y& HA €, dl A ol BrF o1 e AT fpda &1 7 gru
B1?

Ans x1.4fF
x 2.6 f&q
v 3.5fT

x 4.8fcq
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0.98 6 AT BT B Yo 10 GG & AP YoI & RIS &1 @1 AT g1 yfdad srd e
Ans x1.60% g

x 2. 40% oY

¢ 3.40% @A

x 4. 60% TN

0.99 fHHl HET B ggat 20% HeTAT JATdT & 3R B 20% JTAT AT 81 3T YHIR YT T,
Td W@ & 64 $H &1 Jd AWAT Sl1d S|

Ans »1.1600
% 2.2000
x 3.1800

x 4.2100

Q.100 3l 3vficaR] & di9 gU Us gA1d #, Pl Adl § F 25% Hd 3de &1 AY #Hdl 7 A 30% #d
g1 arell 3=fiqaR 900 Ad & 3HdR d &R 11 7dl I el HXAT ol1d $HIfU|

Ans x 1.3250
x 2.3300
v 3.3000

x 4.2250



https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

